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This report contains the data received from the participants in this test.  Since these participants are located in many countries around the world, and it is 
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the results compiled in the Summary Report are not intended to be an overview of the quality of work performed in the profession and cannot be interpreted
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Forensic Audio Analysis Test 25-5591

This test consisted of an evidence audio file. Participants were asked to enhance the audio file to minimize distracting 
elements, and clarify the speech from the incident contained in the file.

SAMPLE PREPARATION: The digital audio was acquired via a predetermined, staged event involving a recording of a 
voicemail and compiled into a .m4a zipped file. Following sample validation, the file was uploaded to the CTS Portal 
for download by test participants. A MD5 and SHA1 digests (cryptographic checksum, or 'hash') were calculated for 
the compressed data and provided to participants to enable validation of a successful download of the file.

VERIFICATION: Predistribution results were consistent with each other and the manufacturer's preparation information. 
The combination of internal test validation and the responses received from the predistribution structured the final 
questions utilized in this test. The following tools were utilized in the validation of this test: QuickHash-GUI (version 
3.3.4), MediaInfo (version 25.04), iZotope RX 11 Advanced Audio Editor, and Audacity (version 3.7.4). CTS does not 
endorse any particular tools.

Manufacturer's Information

SCENARIO PROVIDED TO PARTICIPANTS

A person of interest (POI) claims that he was home alone during a specific time window relevant to an ongoing 
investigation. However, a voicemail stored on a third party’s phone reveals that the POI’s cellular phone, during that 
same period, inadvertently placed a call from a pocket during a one-on-one basketball game at a public court. 
 
Investigators would like to examine the voicemail recording to determine whether any speech or background sounds 
captured during the call contradict the individual’s stated alibi. Audio clarification processing is needed to improve 
listenability and increase intelligibility through noise reduction and speech clarification.
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Manufacturer's Information, continued

 Question  Manufacturer ' s Response  -  Examination Questions

 What is the SHA - 256  hash value of the voicemail - 2095 . m 4 a file ?1-1

Manufacturer's Response:

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EB

 What is the audio format of this MPEG - 4  container file ?1-2

Manufacturer's Response:

Advanced Audio Coding (or Codec) Low Complexity or AAC LC or AAC

 How many audio channels are contained in the audio file ?  Provide a NUMERIC response .1-3

Manufacturer's Response:

1

 What is the length in time of the audio file ?  Provide your answer in the following format :  MM : SS .1-4

Manufacturer's Response:

03:00

 What is the sample rate of the audio file ?  Provide a NUMERIC response and the associated units .1-5

Manufacturer's Response:

8 kHz (8000 Hz)

 What is the frequency value of the tonal noise present ?  Provide a NUMERIC response and the associated 
 units .

1-6

Manufacturer's Response:

Frequency value/Units: 1.2 kHz (1200 Hz)
Are harmonics of this tone present? No

 Are any clipped audio samples present in the file ?1-7

Manufacturer's Response:

Yes

 Question  Manufacturer ' s Response  -  Enhanced Audio Examination

 Describe the workflow used to clarify the audio ,  including specific software and filters applied .2-1

Manufacturer's Response:

This was a free form question on methods and tools used. No manufacturer's response is provided.
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Summary Comments

This test was designed to allow participants to assess their proficiency in data verification, media characterization, data 

analysis, signal analysis and enhancement of an audio file using their own tools and methods. The participants were 

provided with an audio file and were asked to answer questions as well as make enhancements to the audio file. Refer 

to Manufacturer’s Information for preparation details.

A total of 39 participants returned results for this test.

A variety of software tools were used by participants during their examination. The most frequently reported tools 

included Adobe Audition and Izotope RX.  

All seven examination questions achieved consensus. In a separate section of this test, participants were asked to 

perform specific enhancement steps to the audio file and submit these enhanced audio files to CTS. An expert reviewed 

the audio files submitted by participants and provided the observational notes present in Table 3.
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Forensic Audio Examination Responses

TABLE 1
 Question 1- 1 :  Examination Questions

Question 1-1: What is the SHA-256 hash value of the voicemail-2095.m4a file?

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EB Manufacturer ' s 
 Response:

ResponseWebCode

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74eb4BPU69

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74eb4KV2K9

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74eb4VEDX8

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74eb6KCCX8

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74eb7B2AC8

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EB7YALG8

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74eb8QCBL3

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EB9PWEU3

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBCK6D4X

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebCN9ANZ

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebCUU2YZ

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebEXM6GW

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebF6YLNW

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebGW6VGV

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBJBVGZR

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBJEUTVR

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBJKL37Q

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBJRHZTT

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBJWEJVR

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebJXA3WT

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebKJNALR

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebLNANPN

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebM84GBM

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebM9ELLP

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebMFYM4N

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBMND7MM

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebMQUVMQ
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TABLE 1
 Question 1- 1 :  Examination Questions

ResponseWebCode

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebPD7AHM

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBPK6UJH

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebQ29QFM

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBQ2LH7H

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBR9ZQ8K

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBT9EARH

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebU7PMAE

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebUEZPVE

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebVLFPQH

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebYW8DBB

97495995c89fb18006df8104f1f44dafc162a1163bd91e4c53cf03b6575b74ebYZ389C

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EBZ2CVL9

Question 1-1: What is the SHA-256 hash value of the voicemail-2095.m4a file?

97495995C89FB18006DF8104F1F44DAFC162A1163BD91E4C53CF03B6575B74EB Consensus Result:
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TABLE 1
 Question 1- 2 :  Examination Questions

Question 1-2: What is the audio format of this MPEG-4 container file?

Advanced Audio Coding (or Codec) Low Complexity or AAC LC or AAC Manufacturer ' s 
 Response:

ResponseWebCode

AAC LC4BPU69

AAC LC4KV2K9

Advanced Audio Coding - Low Complexity (AAC-LC)4VEDX8

AAC LC (Advanced Audio Codec Low Complexity)6KCCX8

Code Type: audio / mp47B2AC8

AAC LC7YALG8

Quicktime: MPEG4 low complexity AAC8QCBL3

M4A9PWEU3

AAC LCCK6D4X

Advanced Audio Codec Low ComplexityCN9ANZ

Advanced Audio Codec Low Complexity (AAC LC)CUU2YZ

Mp4a or m4a container with AAC LC audio stream codec – please refer to Additional Comments sectionEXM6GW

AAC-LC (Advanced Audio Codec - Low Complexity).F6YLNW

AAC LC (Advanced Audio Codec Low Complexity)GW6VGV

AAC LC Advanced Audio Code Low ComplexityJBVGZR

AAC LC (Advanced Audio Codec Low Complexity)JEUTVR

AAC LC (Advance Audio Codec Low Complexity)JKL37Q

AAC LCJRHZTT

AACJWEJVR

AACJXA3WT

m4a with advanced audio codecKJNALR

(M4A /isom/iso2)LNANPN

AAC LC (Advanced Audio Codec Low Complexity)M84GBM

AACM9ELLP

The format of the audio within the container is AAC LC *see additional commentsMFYM4N

M4AMND7MM

MPEG-4 container file: M4A (M4A /isom/iso2)MQUVMQ

MPEG-4 Audio (AAC codec)PD7AHM
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TABLE 1
 Question 1- 2 :  Examination Questions

ResponseWebCode

AAC-LC (Advanced Audio Codec Low Complexity)PK6UJH

Advanced Audio Codec Low Complexity (AAC LC)Q29QFM

ACCQ2LH7H

AAC LCR9ZQ8K

M4AT9EARH

AACU7PMAE

single stream AAC (Low complexity), 1channel, 8kHz sample rate, data rate (max) 48kb/sUEZPVE

AAC LC (Advanced audio Codec Low Cmplexity)VLFPQH

AAC LCYW8DBB

AAC LCYZ389C

aacZ2CVL9

Question 1-2: What is the audio format of this MPEG-4 container file?

Advanced Audio Coding (or Codec) Low Complexity or AAC LC or AAC Consensus Result:
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TABLE 1
 Question 1- 3 :  Examination Questions

Question 1-3: How many audio channels are contained in the audio file? Provide a NUMERIC response.

1 Manufacturer ' s 
 Response:

ResponseWebCode

14BPU69

14KV2K9

14VEDX8

16KCCX8

17B2AC8

17YALG8

18QCBL3

19PWEU3

1CK6D4X

1CN9ANZ

1CUU2YZ

1EXM6GW

1F6YLNW

1GW6VGV

1JBVGZR

1JEUTVR

1JKL37Q

1JRHZTT

1JWEJVR

1JXA3WT

1KJNALR

1LNANPN

1M84GBM

1M9ELLP

1MFYM4N

1MND7MM

1MQUVMQ

1PD7AHM
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TABLE 1
 Question 1- 3 :  Examination Questions

ResponseWebCode

1PK6UJH

01Q29QFM

1Q2LH7H

1R9ZQ8K

1T9EARH

1U7PMAE

1UEZPVE

1VLFPQH

1YW8DBB

1YZ389C

1Z2CVL9

Question 1-3: How many audio channels are contained in the audio file? Provide a NUMERIC response.

1 Consensus Result:
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TABLE 1
 Question 1- 4 :  Examination Questions

Question 1-4: What is the length in time of the audio file? Provide your answer in the following format: 
MM:SS.

03:00 Manufacturer ' s 
 Response:

ResponseWebCode

03:004BPU69

03:004KV2K9

03:004VEDX8

03:006KCCX8

03:007B2AC8

03:007YALG8

03:008QCBL3

03:009PWEU3

03:00CK6D4X

03:00CN9ANZ

03:00CUU2YZ

03:00EXM6GW

03:00F6YLNW

03:00GW6VGV

03:00JBVGZR

03:00JEUTVR

03:00JKL37Q

03:00JRHZTT

03:00JWEJVR

03:00JXA3WT

3 minutes 0 secondsKJNALR

3:00.480LNANPN

03:00M84GBM

03:00M9ELLP

03:00MFYM4N

3:00.480MND7MM

03 min 00 sMQUVMQ
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TABLE 1
 Question 1- 4 :  Examination Questions

ResponseWebCode

03:00PD7AHM

03:00PK6UJH

03:00Q29QFM

03:00Q2LH7H

03:00R9ZQ8K

03:00T9EARH

03:00.48U7PMAE

03:00UEZPVE

03:00VLFPQH

03:00YW8DBB

03:00YZ389C

03:00Z2CVL9

Question 1-4: What is the length in time of the audio file? Provide your answer in the following format: 
MM:SS.

03:00 Consensus Result:
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TABLE 1
 Question 1- 5 :  Examination Questions

Question 1-5: What is the sample rate of the audio file? Provide a NUMERIC response and the associated 
units.

8 kHz (8000 Hz) Manufacturer ' s 
 Response:

ResponseWebCode

Sample Rate: 8000
Units: Hz

4BPU69

Sample Rate: 8000
Units: Hz

4KV2K9

Sample Rate: 8000
Units: Hz

4VEDX8

Sample Rate: 8000
Units: Hz (Hertz)

6KCCX8

Sample Rate: 8000
Units: Hz

7B2AC8

Sample Rate: 34.7
Units: kb/s

7YALG8

Sample Rate: 8000
Units: Hertz

8QCBL3

Sample Rate: 8000
Units: Hertz (Hz)

9PWEU3

Sample Rate: 8000
Units: Hz

CK6D4X

Sample Rate: 8000
Units: Hz

CN9ANZ

Sample Rate: 8000
Units: Hz

CUU2YZ

Sample Rate: 8000
Units: Hz

EXM6GW

Sample Rate: 8000
Units: Hz

F6YLNW

Sample Rate: 8000
Units: Hertz (Hz)

GW6VGV

Sample Rate: 8000
Units: Hz

JBVGZR

Sample Rate: 8000
Units: Hz

JEUTVR

Sample Rate: 8000
Units: Hz

JKL37Q

Sample Rate: 8000
Units: Hz

JRHZTT

Sample Rate: 8000
Units: Hz

JWEJVR

Sample Rate: 8000
Units: Hz

JXA3WT

Sample Rate: 8000
Units: Hertz

KJNALR
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TABLE 1
 Question 1- 5 :  Examination Questions

ResponseWebCode

Sample Rate: 8000
Units: Hz

LNANPN

Sample Rate: 8000
Units: Hertz (Hz)

M84GBM

Sample Rate: 8000
Units: Hz

M9ELLP

Sample Rate: 8000
Units: Hz

MFYM4N

Sample Rate: 8000
Units: Hz

MND7MM

Sample Rate: 8000
Units: Hz

MQUVMQ

Sample Rate: 8000
Units: Hertz (Hz)

PD7AHM

Sample Rate: 8000
Units: Hertz

PK6UJH

Sample Rate: 8000
Units: Hz

Q29QFM

Sample Rate: 8000
Units: Hz

Q2LH7H

Sample Rate: 8000
Units: Hz

R9ZQ8K

Sample Rate: 8000
Units: Hz

T9EARH

Sample Rate: 8000
Units: Hz

U7PMAE

Sample Rate: 8000
Units: Hertz (Hz)

UEZPVE

Sample Rate: 8000
Units: Hz

VLFPQH

Sample Rate: 8000
Units: Hz

YW8DBB

Sample Rate: 8000
Units: Hertz

YZ389C

Sample Rate: 8000
Units: Hz

Z2CVL9

Question 1-5: What is the sample rate of the audio file? Provide a NUMERIC response and the associated 
units.

Sample Rate: 8000
Units: Hertz (Hz)

 Consensus Result:
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TABLE 1
 Question 1- 6 :  Examination Questions

Question 1-6: What is the frequency value of the tonal noise present? Provide a NUMERIC response and 
the associated units.

Frequency value/Units: 1.2 kHz (1200 Hz)
Are harmonics of this tone present? No

 Manufacturer ' s 
 Response:

ResponseWebCode

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

4BPU69

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

4KV2K9

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

4VEDX8

Frequency Value: 1199
Units: Hz
Are harmonics of this tone present?: Yes

6KCCX8

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

7B2AC8

Frequency Value: 8000
Units: Hz
Are harmonics of this tone present?: Yes

7YALG8

Frequency Value: 1200
Units: Hertz
Are harmonics of this tone present?: No

8QCBL3

Frequency Value: 0
Units: N/A
Are harmonics of this tone present?: Yes [Not within laboratory's scope.]

9PWEU3

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: Yes

CK6D4X

Frequency Value: 1100
Units: Hz
Are harmonics of this tone present?: Yes

CN9ANZ

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

CUU2YZ

Frequency Value: 1.2
Units: kHz
Are harmonics of this tone present?: No

EXM6GW

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

F6YLNW

Frequency Value: 1200
Units: Hertz (Hz)
Are harmonics of this tone present?: No

GW6VGV
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TABLE 1
 Question 1- 6 :  Examination Questions

ResponseWebCode
Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

JBVGZR

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

JEUTVR

Frequency Value: 1199.44
Units: Hz
Are harmonics of this tone present?: Yes

JKL37Q

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

JRHZTT

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

JWEJVR

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

JXA3WT

Frequency Value: 1200
Units: Hertz
Are harmonics of this tone present?: No

KJNALR

Frequency Value: 1.2
Units: Hz
Are harmonics of this tone present?: No

LNANPN

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

M84GBM

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

M9ELLP

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

MFYM4N

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

MND7MM

Frequency Value: 205
Units: Hz
Are harmonics of this tone present?: No

MQUVMQ

Frequency Value: 1200
Units: Hertz (Hz)
Are harmonics of this tone present?: Yes

PD7AHM

Frequency Value: 1200
Units: Hertz
Are harmonics of this tone present?: No

PK6UJH

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

Q29QFM
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TABLE 1
 Question 1- 6 :  Examination Questions

ResponseWebCode

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

Q2LH7H

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

R9ZQ8K

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

T9EARH

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

U7PMAE

Frequency Value: 1200
Units: Hertz (Hz)
Are harmonics of this tone present?: No

UEZPVE

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

VLFPQH

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

YW8DBB

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

YZ389C

Frequency Value: 1200
Units: Hz
Are harmonics of this tone present?: No

Z2CVL9

Question 1-6: What is the frequency value of the tonal noise present? Provide a NUMERIC response and 
the associated units.

Frequency value: 1200
Units: Hertz (Hz)
Are harmonics of this tone present? No

 Consensus Result:
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TABLE 1
 Question 1- 7 :  Examination Questions

Question 1-7: Are any clipped audio samples present in the file?

Yes Manufacturer ' s 
 Response:

ResponseWebCode

Yes4BPU69

No4KV2K9

Yes4VEDX8

Yes6KCCX8

Yes7B2AC8

Yes7YALG8

Yes8QCBL3

Yes9PWEU3

YesCK6D4X

NoCN9ANZ

YesCUU2YZ

YesEXM6GW

YesF6YLNW

YesGW6VGV

YesJBVGZR

YesJEUTVR

YesJKL37Q

YesJRHZTT

YesJWEJVR

YesJXA3WT

YesKJNALR

YesLNANPN

YesM84GBM

NoM9ELLP

YesMFYM4N

YesMND7MM

NoMQUVMQ

YesPD7AHM
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TABLE 1
 Question 1- 7 :  Examination Questions

ResponseWebCode

YesPK6UJH

YesQ29QFM

YesQ2LH7H

NoR9ZQ8K

YesT9EARH

YesU7PMAE

YesUEZPVE

NoVLFPQH

YesYW8DBB

NoYZ389C

YesZ2CVL9

Question 1-7: Are any clipped audio samples present in the file?

Yes Consensus Result:
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Forensic Audio Enhancement Responses
TABLE 2

 Question 2- 1 : Enhanced Audio Examination 
Question 2-1: Describe the workflow used to clarify the audio, including specific software and filters 
applied.

This was a free form question on methods and tools used. No manufacturer's response is 
provided.

 Manufacturer ' s
 Response:

ResponseWebCode

Continuous tone attenuation: I used the EQ module in Izoptope RX10 to apply a notch/bell filter at 
1200Hz (-60dB gain), with a narrow Q (400.0). This effectively attenuated the continuous tone without 
negative impact on speech intelligibility.
Noise reduction: This recording contains handling/rustling noise throughout, with prominent low 
frequency/low mid frequency energy. To reduce this, I first used EQ in Izoptope RX10 to apply a brickwall 
high pass filter at 100Hz and a brickwall low pass filter at 4000Hz to remove unwanted low and high 
frequency content. I then used the De-Wind module in RX10 to reduce some of the low frequency energy 
in the noise (crossover frequency set to 400Hz to reduce noise below this frequency, reduction set to 3.0 
and fundamental recovery set to 5.0) and improve overall listenability. Finally, I used De-Rustle in RX10 
(reduction set to 2.5) to provide further reduction of the handling noise across the full spectrum of the 
recording.
Processed file normalization (-3 dB): After all processing was applied, i used the Normalize module in 
RX10 to set the target peak level (dBFS) to -3dB.
Additional Clarification: Prior to applying EQ and noise reduction, I used De-Clip in RX10 to repair 
digitally clipped samples, with the threshold set to -0.5dB. After applying EQ and noise reduction, I used 
the Fab Filter Pro-L2 to reduce the difference between the louder and quieter speech. I set the attack to 
67ms, the release to 264ms, with gain of 12dB applied and an output ceiling of -0.5dBTP. The file was 
then normalised to -3dB as the last step in the chain. Processing chain: De-Clip - repair clipped samples 
> EQ - HPF @100Hz, LPF@4kHz, Notch at 1200Hz to attenuate continuous tone > De-Wind - reduce 
low and low mid frequency energy from the noise >De-Rustle - further reduction of handling/rustling noise 
> Fab Filter Pro-L2 - reduce difference between louder and quieter speech > Normalize - normalise file to 
-3dBFS.

4BPU69

Continuous tone attenuation: Using Audacity software, a continuous beep tone was identified. Analzye 
'Plot Spectrum' to identified the spike tone frequency on '1200Hz'. Then applied a 'Notch Filter' and set 
Frequency(Hz) value '1200' with Q value '20'.
Noise reduction: Using Audacity software, select a section containing the noise, then use 'Noise Reduction' 
filter and select 'Get Noise Profile' from the settings to captured the noise. Then applied 'Noise Reduction' 
again to the entire audio file with settings (Noise Reduction(dB)=8, Sensitivity=6, Frequency 
Smoothing(bands)=6).
Processed file normalization (-3 dB): Using Audacity software, applied a 'Normalize' filter with settings 
Normalize peak amplitude to '-3.0' dB.
Additional Clarification: Using Audacity software, applied a 'Filter Curve EQ', 'Normalize', 'Compressor', 
'Limiter' effects to get a better speech sound.

4KV2K9

Continuous tone attenuation: Adobe Audition "Frequency Analysis" tool: Visual observation of a large peak 
between 1180 Hz and 1220 Hz. Found the exact peak frequency by right clicking on the Frequency 
Analysis graph and copying the graph data to a text file. In the resulting table there is a peak value 
between 1199.95 and 1200.07 Hz, rounded down to 1200 Hz. Applied a "Notch Filter" in Adobe 
Audition: 1200 Hz, gain -50 dB, Notch Width: Super Narrow
Noise reduction: Adobe Audition: "Dynamics Processing" (expander/compressor combination) to amplify 
the softer sounds and reduce the level of the loud peaks. Applied a "Hard Limiter" to reduce te level of 
these loud peaks more.
Processed file normalization (-3 dB): Adobe Audition: "Normalize (Process)" to -3 dB.
Additional Clarification: All steps always involved listening to the audio before/while/after making 
changes.

4VEDX8
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ResponseWebCode

Continuous tone attenuation: We began by working in the DC Live software, where a notch filter was 
applied at 1199 Hz. This adjustment lowered the intensity of that specific frequency to diminish the 
persistent tone while avoiding any negative impact on speech intelligibility.
Noise reduction: Broadband background noise was reduced using iZotope RX 10's Voice De-noise 
module. The process was optimized for dialogue, with the filter set to "Surgical" mode to maintain speech 
integrity. A noise profile was learned from a low-speech segment, and a moderate reduction setting was 
applied to attenuate the steady noise floor while preserving the natural characteristics of the target speech.
Processed file normalization (-3 dB): The audio file was peak-normalized using the Normalize module in 
iZotope RX 10. The target peak level was set to –3.0 dBFS.
Additional Clarification: [Not reported by participant.]

6KCCX8

Continuous tone attenuation: The audio file was processed using (Sound Cleaner II) v1.04.944 software 
to enhance speech clarity and remove background noise. The file was imported into Sound Cleaner and 
analysed for unwanted noise such as continuous tones and ambient hiss.
Noise reduction: The following filters were applied: 1. Broadband Noise Reduction: o Suppression depth: 
19 dB, o Adaptation time: 0.2 s. 2. Equalizer: o Mode: Accumulated, o Scale: Logarithmic, o Band: 
600-800-2048 Hz. 3. Amplifier was applied to adjust the overall signal level.
Processed file normalization (-3 dB): Finally, the processed audio was normalised to –3 dB using «SIS II» 
Audio Forensic Software (STC-S521) v2.8.215 software and saved in uncompressed PCM WAV format, 
maintaining the original sample rate.
Additional Clarification: Continuous tone attenuation was achieved by applying the broadband noise 
reduction and equaliser filters, effectively reducing steady low-frequency hum while preserving the natural 
characteristics of the speech. The amplifier helped optimise the signal level before normalisation, ensuring 
consistent output without distortion.

7B2AC8

Continuous tone attenuation: Sound Remover Filter: Sound Model Complexity - 10, Sound Refinement 
Passes - 40, Content Complexity - 10, Content Refinement Passes - 40, Enhanced for Speech - FFT Size 
4096
Noise reduction: Declipper: Gain - -1dB, Tolerance - 1%, Min. Clip Size - 3 samples, Interpolation - 
Cubic, 1 problem detected. 1 problem repaired. DeReverb: 70%. Hard Limiter: Peak, Maximum 
Amplitude - -9.0dB, Input Boost 6.0dB, Look-Ahead Time - 7ms, Release Time - 100ms. Notch Filter: 
Frequency - 30.0Hz, Gain - -95.1, Notch Width - Narrow, Ultra Quiet
Processed file normalization (-3 dB): Normalised to -3dB before saving in .wav format.
Additional Clarification: [Not reported by participant.]

7YALG8

Continuous tone attenuation: Fast Fourier Transform (FFT) file set from 1187-1227 Hz for entire file.
Noise reduction: Captured NR profiles from various points in the file that were in the proximity of 
conversation and applied to conversations throughout file. Amplification applied to NR.
Processed file normalization (-3 dB): Applied normalization process to entire file to -3db once 
enhancement completed.
Additional Clarification: Applied stretch/pitch (iZotope radius, set to preserve speech characteristics with a 
low pitch shift/semitone and pitch coherence) to certain conversations to enhance recognizable speech.

8QCBL3
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Continuous tone attenuation: The continuous tone attenuation relied on the implementation of the Notch 
filter to mitigate the tonal value at 1200 hertz; this was achievable via Adobe Audition's notch filter 
functionality,. The Notch filter allows the attenuation based on specific frequency (defined by the notch 
width, which was set to very narrow); this prevents the attenuation of the surrounding frequencies. I set the 
attenuation by -80.db to ensure the continuous tone would be eliminated. I did not enable the ultra quiet 
or set gain to parameters.
Noise reduction: I implemented both the noise reduction and sound remover and captured both the sound 
print and sound model of the unwanted natural noise of the audio recording and made attempts to 
attenuate it. The red and yellow lines represent the the lower noise and the higher amplitude noise 
(commonly references as the noise floor). The green frequency parameter represents the threshold for the 
noise floor reduction. I set the threshold to the higher noise floor since more unwanted noises existed in 
that range. The additional parameters relate Reduce by and Noise Reduction; these relate to how much 
you want to reduce the amplification by and controlling how much noise reduction is applied to the audio. 
The noise reduction filter necessitates a noise print (a section of capture audio), so I attempted to capture 
a localized section of the audio that does not contain conversational aspects. I also implemented the 
sound remover filter (that utilizes a sound model learning, similar to noise print) to remove additional 
unwanted noise. Content complex and sound complexity relates to the convoluted noises within the audio 
signal based on all frequencies. The reduce by relates to the DE amplification and the refinement assists in 
providing a more accurate signal post processing.
Processed file normalization (-3 dB): I utilized the Adobe Audition functionality to normalize the audio to -3 
so the volume that was quieter would sound a bit louder while making the louder audio sound quieter
Additional Clarification: The additional Clarifications derive from the recommended enhancement order of 
operations within the Audio Forensic Fundamentals from the Audio Engineering Society (AES); these 
incorporate the Parametric Equalizer, Hard Limiter, Amplify, and De-reverberation. The hard limiter greatly 
attenuates sound about a specified decibel; this was implemented to the preset -3 db, which also assists in 
hearing the lower noises based off of the input boost. The Parametric equalizer assists in attenuating 
frequencies based off of the low pass filter. The de-reverberation auto detects resonating noises from all 
frequencies and mitigates those noises based on a percentile, while amplify can boost or attenuate a 
signal

9PWEU3

Continuous tone attenuation: Using SIS Specialty Sound Editor (STC-S521) version 3.1.10.462, the 
analysis of spectrum showed a continuous tone at frequency 1200 Hz. The Noise Reduction Module in the 
Processing menu was used to remove the tone noise. Frame size: Auto
Noise reduction: Using SIS Specialty Sound Editor (STC-S521) version 3.1.10.462, in the Noise Reduction 
Module in the Processing menu was used:- 1. Checkbox of Remove Wide-band Noise were enable with 
the following parameter: • Maximal Gain, dB : 20dB 2. Checkbox of Inverse Filter were enabled with the 
following parameter: • Suppressing Gain 40 dB • Amplification Gain: 25 dB • Frame Size: Auto • 
Automatic Speech Equalizer: Enabled Processing Mode: Entire Signal
Processed file normalization (-3 dB): Using SIS Specialty Sound Editor (STC-S521) version 3.1.10.462 , 
after Continous Tone Attenuation and Noise Reduction steps were performs, All waveforms in the entire 
signal were selected, and the Normalization module under the Processing menu was used and parameter 
of amplitude level set to −3 dB.
Additional Clarification: Using SIS Specialty Sound Editor (STC-S521) version 3.1.10.462 , the signal of 
characteristics the original audio file showed clipping detected at 0.05 s (0.03%). After applying Continous 
Tone Attenuation , Noise Reduction and Normalization steps were performs normalization to −3 dB, the 
signal analysis showed no clipping detected. The audio conversation became clearer after the processing

CK6D4X
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Continuous tone attenuation: Audacity - I did a frequency analysis on a part of the audio with only the 
tone. I determined the tone was in a frequency range of 1150 - 1250. I used a Graphic EQ to lower that 
range of frequencies to zero.
Noise reduction: Audacity - I did a frequency analysis on a part of the audio with only the speaker's voice. 
I determined the voice was a frequency around 800Hz. In parts of the audio where noise was covering the 
voice, I used the Noise Reduction effect to lower the volume of the noise. I then used a Graphic EQ to 
increase the volume of frequencies in the range of 630Hz to 1000Hz (voice). I used the Amplify effect on 
each segment to make the amplitude similar across the entire audio. I exported the audio to a WAV 
signed 16-bit PCM file.
Processed file normalization (-3 dB): Audacity - I used the Normalize tool and normalized peak amplitude 
to -3dB. I exported the audio to a WAV signed 16-bit PCM file.
Additional Clarification: There were two segments that were only very loud noise, so I muted those 
segments entirely.

CN9ANZ

Continuous tone attenuation: iZotope RX10: De hum: -55 dB at 1200 Hz
Noise reduction: 1. iZotope RX10: De click: Sensitivity: 10, Click widening: 5 ms 2. iZotope RX10: 
Dialogue isolate: Dialogue gain: 4 db, Noise gain: -3 dB, Sensitivity: 10 3. iZotope RX10: Equalizer 4. 
Adobe Audition CS6, Noise reduction (-10 dB) Time range: 00:37.000 – 00:45.200, 00:55.000 – 
00:57.900, 1:00.500 – 1:08.300, 1:26.800 – 1:28.200, 1:42.700 – 1:45.600, 1:46.700 – 1:49.800, 
2:38.500 – 2:51.800 6.
Processed file normalization (-3 dB): Adobe Audition CS6 (Hard limiter)
Additional Clarification: -

CUU2YZ

Continuous tone attenuation: 1. DeClick 2. Gain down -2 3. DeClip 4. Continuous tone attenuation: 
DeHum 1200 Hz 5. EQ
Noise reduction: 6.
Noise reduction: DeWind 7. Leveler
Processed file normalization (-3 dB): 8. Processed file normalization (-3dB): Normalization to -3 dB 9. 
Export pcm wav file named "voicemail-2095_A5_Convert_Chain04.wav"
Additional Clarification: NA

EXM6GW

Continuous tone attenuation: Applied a notch filter at 1200 Hz (Q=30) to attenuate the continuous tonal 
noise present throughout the recording. This removes the narrowband tone without affecting surrounding 
speech frequencies. Select the entire track (Ctrl +A). Go to Effect > Notch Filter… In the dialog: 
Frequency (Hz): 1200 Q: 30 (higher Q = narrower cut, safer for speech) Click Apply (or OK).
Noise reduction: Identified a segment containing only background noise (00:09:220 - 00:09:690). 
Performed Noise Reduction > Get Noise Profile. Applied broadband noise reduction with:
Noise reduction: 12 dB, Sensitivity: 6, Frequency Smoothing: 6 bands, Applied processing to entire file to 
reduce ambient noise while preserving speech.
Processed file normalization (-3 dB): Select all audio again (Ctrl +A). Go to Effect > Normalize… Check 
Normalize peak amplitude to: -3 dB. Click OK.
Additional Clarification: No dynamic range compression or EQ was applied to avoid altering the original 
speech characteristics beyond necessary intelligibility improvements.

F6YLNW

Continuous tone attenuation: Adobe Audition - Band-reject filter at 1200 Hz with a -40 dB attenuation.
Noise reduction: Adobe Audition - Clip reduction using the DeClipper filter (normal intensity). - Intensive 
click reduction using the DeClicker filter (applied three times). - FFT filter applied to attenuate frequencies 
between 20 and 30 Hz, targeting subsonic vibrations. - Automatic click remover was applied. - Noise 
attenuation using selection tools and the spot healing brush. - Noise reduction set to 5% and 5 dB, with an 
FFT size of 2048. - Reverb cancellation applied at 30% intensity.
Processed file normalization (-3 dB): Adobe Audition - Vocal enhancer filter applied to improve voice 
presence. - Multiband compressor used to boost vocal frequencies. - Normalization set to -3 dB to ensure 
consistent output levels.
Additional Clarification: [Not reported by participant.]

GW6VGV
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Continuous tone attenuation: The tonal noise was identified using Adobe Audition ver. 25 Frequency 
Analysis FFT and Spectral Frequency Display spectrograph. The m4a file was converted to a WAV PCM file 
format with the same sampling rate for use with the SES Omega ver. 1.0.12 forensic processing software. 
The WAV file was imported into the SES software to attenuate noise and increase intelligibility and 
clarification. I used the Tone Removal filter to attenuate the 1200 Hz tone, see filter chart below, settings 
in Tonal Removal section. Speech Extraction System-SES Ω v1.0.12 Copyright 1996-2025 Intelligent 
Devices, Inc. Status Report Main Settings { Input Mode { Sum } Output Level { 9 dB } } Engine 0 - Scene 
1 - Time 0h 00m 00.000s -> END { Talker 1 { Differential { OFF } Distortion/Click { Clip Detection 
Threshold { 25 } Click Detection Threshold { 48 } } Hum Removal { OFF } Smooth Adaptive { OFF } 
Band Limiter { Low { 108 Hz } High { 4005 Hz } Attenuation { 40.0 dB } Low Enhance { BOOST } Mid 
Enhance { BOOST } High Enhance { OFF } } Parametric EQ { OFF } Harmonic Notch { OFF } Tone 
Removal { Deviation Decision Threshold { 88.4 } Adjacent Band Latching { 0 Hz } Scan Cycle Duration { 
7.9 sec } Tone Rejection { 96 dB } Removed Tone List: 21.0 Hz - 42.0 Hz 1134.0 Hz - 1218.0 Hz 
6132.0 Hz - 6174.0 Hz 6594.0 Hz - 6678.0 Hz 6846.0 Hz - 6867.0 Hz 7791.0 Hz - 7833.0 Hz 8904.0 
Hz - 9030.0 Hz 9135.0 Hz - 9261.0 Hz 9387.0 Hz - 9408.0 Hz 9471.0 Hz - 9492.0 Hz 9555.0 Hz - 
9618.0 Hz 9828.0 Hz - 9891.0 Hz 9912.0 Hz - 9933.0 Hz 10017.0 Hz - 10059.0 Hz 10101.0 Hz - 
10122.0 Hz 10227.0 Hz - 10290.0 Hz 10395.0 Hz - 10458.0 Hz 10500.0 Hz - 10521.0 Hz 10584.0 
Hz - 10605.0 Hz 10752.0 Hz - 10773.0 Hz 10794.0 Hz - 10857.0 Hz 11088.0 Hz - 11109.0 Hz 
11130.0 Hz - 11151.0 Hz 11256.0 Hz - 11277.0 Hz 11487.0 Hz - 11550.0 Hz 11592.0 Hz - 11613.0 
Hz 11907.0 Hz - 11970.0 Hz 12264.0 Hz - 12306.0 Hz 12327.0 Hz - 12369.0 Hz 12558.0 Hz - 
12621.0 Hz 12936.0 Hz - 12957.0 Hz 13167.0 Hz - 13188.0 Hz 13230.0 Hz - 13293.0 Hz 13356.0 
Hz - 13377.0 Hz 13419.0 Hz - 13545.0 Hz 13566.0 Hz - 13587.0 Hz 13608.0 Hz - 13629.0 Hz 
13755.0 Hz - 13776.0 Hz 13860.0 Hz - 13881.0 Hz 13944.0 Hz - 13986.0 Hz 14112.0 Hz - 14133.0 
Hz 14280.0 Hz - 14322.0 Hz 14343.0 Hz - 14364.0 Hz 14469.0 Hz - 14490.0 Hz 14595.0 Hz - 
14658.0 Hz 14952.0 Hz - 14994.0 Hz 15036.0 Hz - 15057.0 Hz 15120.0 Hz - 15141.0 Hz 15288.0 
Hz - 15309.0 Hz 15372.0 Hz - 15393.0 Hz 15624.0 Hz - 15645.0 Hz 15897.0 Hz - 15918.0 Hz 
15939.0 Hz - 15981.0 Hz 16611.0 Hz - 16653.0 Hz 16968.0 Hz - 17010.0 Hz 17115.0 Hz - 17178.0 
Hz 17220.0 Hz - 17346.0 Hz 17409.0 Hz - 17430.0 Hz 17472.0 Hz - 17493.0 Hz 17619.0 Hz - 
17682.0 Hz 17955.0 Hz - 17997.0 Hz 18312.0 Hz - 18354.0 Hz 18480.0 Hz - 18501.0 Hz 18648.0 
Hz - 18669.0 Hz 18984.0 Hz - 19005.0 Hz 19299.0 Hz - 19341.0 Hz 19551.0 Hz - 19572.0 Hz 
19593.0 Hz - 19614.0 Hz 19635.0 Hz - 19698.0 Hz 19803.0 Hz - 19845.0 Hz 19908.0 Hz - 19929.0 
Hz 19971.0 Hz - 20034.0 Hz 20307.0 Hz - 20370.0 Hz 20643.0 Hz - 20664.0 Hz End of Removed 
Tone List } Adaptive Extract { OFF } Noise Reduction { OFF } Telecom Enhance { OFF } IQ Curve 
Match { OFF } Voice Level Normalizer { Threshold { -15.0 } Compression { 8.0 } Compensation Gain { 
0.0 }
Noise reduction: SES Omega ver. 1.0.12 forensic processing software was used for noise reduction. The 
Bandwidth Limiter was used to reduce any noise outside the sample rate and attenuate any low frequency 
rumble. A Distortion/Click filter was used to repair any clipping and reduce any severe impact noises. A 
Voice Level Normalizer Compression Amplifier was used to further reduce the impact noise and help 
clarify the speech by improving the signal to noise ratio. See filter chart below, settings in Distortion/Click 
and Voice Level Normalizer section. Speech Extraction System-SES Ω v1.0.12 Copyright 1996-2025 
Intelligent Devices, Inc. Status Report Main Settings { Input Mode { Sum } Output Level { 9 dB } } Engine 
0 - Scene 1 - Time 0h 00m 00.000s -> END { Talker 1 { Differential { OFF } Distortion/Click { Clip 
Detection Threshold { 25 } Click Detection Threshold { 48 } } Hum Removal { OFF } Smooth Adaptive { 
OFF } Band Limiter { Low { 108 Hz } High { 4005 Hz } Attenuation { 40.0 dB } Low Enhance { BOOST 
} Mid Enhance { BOOST } High Enhance { OFF } } Parametric EQ { OFF } Harmonic Notch { OFF } 
Tone Removal { Deviation Decision Threshold { 88.4 } Adjacent Band Latching { 0 Hz } Scan Cycle 
Duration { 7.9 sec } Tone Rejection { 96 dB } Removed Tone List: 21.0 Hz - 42.0 Hz 1134.0 Hz - 
1218.0 Hz 6132.0 Hz - 6174.0 Hz 6594.0 Hz - 6678.0 Hz 6846.0 Hz - 6867.0 Hz 7791.0 Hz - 7833.0 
Hz 8904.0 Hz - 9030.0 Hz 9135.0 Hz - 9261.0 Hz 9387.0 Hz - 9408.0 Hz 9471.0 Hz - 9492.0 Hz 
9555.0 Hz - 9618.0 Hz 9828.0 Hz - 9891.0 Hz 9912.0 Hz - 9933.0 Hz 10017.0 Hz - 10059.0 Hz 
10101.0 Hz - 10122.0 Hz 10227.0 Hz - 10290.0 Hz 10395.0 Hz - 10458.0 Hz 10500.0 Hz - 10521.0 
Hz 10584.0 Hz - 10605.0 Hz 10752.0 Hz - 10773.0 Hz 10794.0 Hz - 10857.0 Hz 11088.0 Hz - 
11109.0 Hz 11130.0 Hz - 11151.0 Hz 11256.0 Hz - 11277.0 Hz 11487.0 Hz - 11550.0 Hz 11592.0 

JBVGZR
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Hz - 11613.0 Hz 11907.0 Hz - 11970.0 Hz 12264.0 Hz - 12306.0 Hz 12327.0 Hz - 12369.0 Hz 
12558.0 Hz - 12621.0 Hz 12936.0 Hz - 12957.0 Hz 13167.0 Hz - 13188.0 Hz 13230.0 Hz - 13293.0 
Hz 13356.0 Hz - 13377.0 Hz 13419.0 Hz - 13545.0 Hz 13566.0 Hz - 13587.0 Hz 13608.0 Hz - 
13629.0 Hz 13755.0 Hz - 13776.0 Hz 13860.0 Hz - 13881.0 Hz 13944.0 Hz - 13986.0 Hz 14112.0 
Hz - 14133.0 Hz 14280.0 Hz - 14322.0 Hz 14343.0 Hz - 14364.0 Hz 14469.0 Hz - 14490.0 Hz 
14595.0 Hz - 14658.0 Hz 14952.0 Hz - 14994.0 Hz 15036.0 Hz - 15057.0 Hz 15120.0 Hz - 15141.0 
Hz 15288.0 Hz - 15309.0 Hz 15372.0 Hz - 15393.0 Hz 15624.0 Hz - 15645.0 Hz 15897.0 Hz - 
15918.0 Hz 15939.0 Hz - 15981.0 Hz 16611.0 Hz - 16653.0 Hz 16968.0 Hz - 17010.0 Hz 17115.0 
Hz - 17178.0 Hz 17220.0 Hz - 17346.0 Hz 17409.0 Hz - 17430.0 Hz 17472.0 Hz - 17493.0 Hz 
17619.0 Hz - 17682.0 Hz 17955.0 Hz - 17997.0 Hz 18312.0 Hz - 18354.0 Hz 18480.0 Hz - 18501.0 
Hz 18648.0 Hz - 18669.0 Hz 18984.0 Hz - 19005.0 Hz 19299.0 Hz - 19341.0 Hz 19551.0 Hz - 
19572.0 Hz 19593.0 Hz - 19614.0 Hz 19635.0 Hz - 19698.0 Hz 19803.0 Hz - 19845.0 Hz 19908.0 
Hz - 19929.0 Hz 19971.0 Hz - 20034.0 Hz 20307.0 Hz - 20370.0 Hz 20643.0 Hz - 20664.0 Hz End 
of Removed Tone List } Adaptive Extract { OFF } Noise Reduction { OFF } Telecom Enhance { OFF } IQ 
Curve Match { OFF } Voice Level Normalizer { Threshold { -15.0 } Compression { 8.0 } Compensation 
Gain { 0.0 }
Processed file normalization (-3 dB): The processed audio was exported from SES Omega forensic 
software ver. 1.0.12 in a WAV/PCM file format with 8000Hz sample rate and 32-bit sample size. The 
processed audio was imported into Adobe Audition ver. 25 which was used to normalize the processed 
file. Using the Normalize effect from the Amplitude and Compression category of effects allowed me to 
type in the exact value of normalization required (-3dB).
Additional Clarification: I used SES Omega ver. 1.0.12 to do additional clarification. From the Bandwidth 
Limiter filter I applied additional gain (+6dB) across the speech frequency range, low and middle 
frequencies (100Hz – 1500 Hz. This helped increase the speech levels. I used the Voice Level Normalizer 
Compression Amplifier filter to attenuate the louder impact noises and increase the listenability of the 
recording. After analyzing the recording with a Waveform monitor I was able to pinpoint the sound levels 
for speech and noise to properly configure the Compression Amplifier. See filter chart below, settings in 
the Bandwidth Limiter and Voice Level Normalizer section. Speech Extraction System-SES Ω v1.0.12 
Copyright 1996-2025 Intelligent Devices, Inc. Status Report Main Settings { Input Mode { Sum } Output 
Level { 9 dB } } Engine 0 - Scene 1 - Time 0h 00m 00.000s -> END { Talker 1 { Differential { OFF } 
Distortion/Click { Clip Detection Threshold { 25 } Click Detection Threshold { 48 } } Hum Removal { 
OFF } Smooth Adaptive { OFF } Band Limiter { Low { 108 Hz } High { 4005 Hz } Attenuation { 40.0 dB 
} Low Enhance { BOOST } Mid Enhance { BOOST } High Enhance { OFF } } Parametric EQ { OFF } 
Harmonic Notch { OFF } Tone Removal { Deviation Decision Threshold { 88.4 } Adjacent Band Latching 
{ 0 Hz } Scan Cycle Duration { 7.9 sec } Tone Rejection { 96 dB } Removed Tone List: 21.0 Hz - 42.0 
Hz 1134.0 Hz - 1218.0 Hz 6132.0 Hz - 6174.0 Hz 6594.0 Hz - 6678.0 Hz 6846.0 Hz - 6867.0 Hz 
7791.0 Hz - 7833.0 Hz 8904.0 Hz - 9030.0 Hz 9135.0 Hz - 9261.0 Hz 9387.0 Hz - 9408.0 Hz 9471.0 
Hz - 9492.0 Hz 9555.0 Hz - 9618.0 Hz 9828.0 Hz - 9891.0 Hz 9912.0 Hz - 9933.0 Hz 10017.0 Hz - 
10059.0 Hz 10101.0 Hz - 10122.0 Hz 10227.0 Hz - 10290.0 Hz 10395.0 Hz - 10458.0 Hz 10500.0 
Hz - 10521.0 Hz 10584.0 Hz - 10605.0 Hz 10752.0 Hz - 10773.0 Hz 10794.0 Hz - 10857.0 Hz 
11088.0 Hz - 11109.0 Hz 11130.0 Hz - 11151.0 Hz 11256.0 Hz - 11277.0 Hz 11487.0 Hz - 11550.0 
Hz 11592.0 Hz - 11613.0 Hz 11907.0 Hz - 11970.0 Hz 12264.0 Hz - 12306.0 Hz 12327.0 Hz - 
12369.0 Hz 12558.0 Hz - 12621.0 Hz 12936.0 Hz - 12957.0 Hz 13167.0 Hz - 13188.0 Hz 13230.0 
Hz - 13293.0 Hz 13356.0 Hz - 13377.0 Hz 13419.0 Hz - 13545.0 Hz 13566.0 Hz - 13587.0 Hz 
13608.0 Hz - 13629.0 Hz 13755.0 Hz - 13776.0 Hz 13860.0 Hz - 13881.0 Hz 13944.0 Hz - 13986.0 
Hz 14112.0 Hz - 14133.0 Hz 14280.0 Hz - 14322.0 Hz 14343.0 Hz - 14364.0 Hz 14469.0 Hz - 
14490.0 Hz 14595.0 Hz - 14658.0 Hz 14952.0 Hz - 14994.0 Hz 15036.0 Hz - 15057.0 Hz 15120.0 
Hz - 15141.0 Hz 15288.0 Hz - 15309.0 Hz 15372.0 Hz - 15393.0 Hz 15624.0 Hz - 15645.0 Hz 
15897.0 Hz - 15918.0 Hz 15939.0 Hz - 15981.0 Hz 16611.0 Hz - 16653.0 Hz 16968.0 Hz - 17010.0 
Hz 17115.0 Hz - 17178.0 Hz 17220.0 Hz - 17346.0 Hz 17409.0 Hz - 17430.0 Hz 17472.0 Hz - 
17493.0 Hz 17619.0 Hz - 17682.0 Hz 17955.0 Hz - 17997.0 Hz 18312.0 Hz - 18354.0 Hz 18480.0 
Hz - 18501.0 Hz 18648.0 Hz - 18669.0 Hz 18984.0 Hz - 19005.0 Hz 19299.0 Hz - 19341.0 Hz 
19551.0 Hz - 19572.0 Hz 19593.0 Hz - 19614.0 Hz 19635.0 Hz - 19698.0 Hz 19803.0 Hz - 19845.0 
Hz 19908.0 Hz - 19929.0 Hz 19971.0 Hz - 20034.0 Hz 20307.0 Hz - 20370.0 Hz 20643.0 Hz - 
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20664.0 Hz End of Removed Tone List } Adaptive Extract { OFF } Noise Reduction { OFF } Telecom 
Enhance { OFF } IQ Curve Match { OFF } Voice Level Normalizer { Threshold { -15.0 } Compression { 
8.0 } Compensation Gain { 0.0 }

Continuous tone attenuation: RX iZotope De-hum: giving him to learn a zone of silence where there is only 
the tone, to remove the 1200 Hz tone.
Noise reduction: RX iZotope Spectral Repair: in areas where there is noise, friction and ball bouncing, 
taking great care to keep the areas where voices are heard so as not to modify them excessively. RX 
iZotope De-crackle: to remove brief spikes from violent friction or impacts with the microphone. RX 
iZotope De-click: treat friction noises from clothing or the body itself that are transmitted through the 
microphone.
Processed file normalization (-3 dB): RX iZotope Normaize: selecting Target peak level [dBFS] at -3.00
Additional Clarification: RX iZotope EQ: to equalize the frequencies where the voice is most important RX 
iZotope Leveler: optimize for Dialogue to adjust the levels of the different speakers where the voice 
fluctuates greatly in distance from the microphone or in volume.

JEUTVR

Continuous tone attenuation: full audio clip has a 1.2k hum Software used: Adobe Audition
Noise reduction: Used "sound remover - effect" with preset setting and added "enhance for speech" Used 
"Declicker" Software used: Adobe Audition
Processed file normalization (-3 dB): go to "effects", choose "amplitude & compression", choose 
"Normalize", type in "-3", choose dB (not percentage as already preselected) Software used: Adobe 
Audition
Additional Clarification: N/A

JKL37Q

Continuous tone attenuation: The .m4a file was opened in Adobe Audition 2021 and saved as .wav file 
with the original sampling rate, channel, and bit depth. Then the .wav file was opened in "iZotope RX 10 
Advanced (64-bit) v10.3.0.1775". The continuous tone was attenuated with its De-hum module with the 
following parameters: Learn, Filter DC offset, Filter type: Static, Frequency: 1200, Q: 224, Harmonics: 1.
Noise reduction: Adobe Audition: Selected areas were normalized to 90% for vocal and 80% for some 
background sounds to make them clearer. iZotope RX 10 Advanced: Then Dialogue Isolate module was 
used to suppress some unwanted signal.Dialogue gain 0 dB, Noise gain 0 dB, Sensitivity 8.0, Ambience 
preservation 80, Quality (Best).
Processed file normalization (-3 dB): Adobe Audition's normalization was used with parameters -3, dB, DC 
offset 0.0%.
Additional Clarification: None.

JRHZTT

Continuous tone attenuation: iZotope RX 11 Pro > EQ band: 1200 Hz -60 dB gain with a Q of 400 and 
frequency precision of 3 Hz
Noise reduction: all steps undertaken in iZotope RX 11 Pro 1 - marked sections with audible speech 2 - 
applied -30 dB gain to sections without speech 3 - applied de-rustle to sections with audible speech + 
rustle 4 - applied voice de-noise to whole file 5 - applied normalize to 3 dB to sections with speech
Processed file normalization (-3 dB): 6 - applied normalize to 3 dB to whole file
Additional Clarification: saved as WAV file with 24 bit and white noise dither

JWEJVR
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Continuous tone attenuation: Process Chain : channels : 2 sample rate : 8000.00 EQ - Linear Phase 
Current Settings : on/off: on LS1 frequency : 191.57, 191.57 Hz gain : -50.00, -50.00 dB slope : 
120.00 dB/octave HS1 frequency : 3476.95, 3476.95 Hz gain : -50.00, -50.00 dB slope : 120.00 
dB/octave Debuzz-3 Current Settings : on/off: on frequency : 500.00 Hz threshold : 0.00, 0.00 dB 
reduction : -96.00, -96.00 dB bandwidth : 5000.00, 5000.00 Hz detection channels : 1, 2 tracking : on 
harmonic mode : all Compressor Current Settings : on/off: on threshold : -1.00, -1.00 dB knee : 3.37, 
3.37 dB makeup gain : 10.03, 10.03 dB read ahead : 0.00, 0.00 ms attack : 0.01, 0.01 ms hold : 
20.00, 20.00 ms release : 333.00, 333.00 ms ratio : 11.84, 11.84 parallel : -50.00, -50.00 dB link : 
on link channels : 1, 2 side chain Vintage Decrackle Current Settings : on/off: on mode : crackle 2 detect 
: on split level : 37.33, 37.33 dB auto split : off threshold : 40.00, 40.00 FNR Current Settings : on/off: 
on speed : 0.20, 0.20 Hz resolution : optimal bias : 0.00, 0.00 dB attenuation : -5.53, -5.53 dB focus : 
82.00, 82.00 DNS Two Current Settings : on/off: on threshold bias : 0.00, 0.00 dB attenuation : -2.73, 
-2.73 dB learn : false SUMMARY: Track Loudness View Standard : ATSC A/85 Loudness : -19.54 LKFS 
True Peak : 1.55 dB TP Compliant : false Out of range : Loudness ,True Peak
Noise reduction: see above
Processed file normalization (-3 dB): Adobe Audition Normalization -3 dB
Additional Clarification: see above

JXA3WT

Continuous tone attenuation: The Adobe Audition notch filter was applied to reduce the tonal noise at 
1200 Hz.
Noise reduction: The Adobe Audition 30 band graphic equalizer was applied to reduce broadband noise 
below 200 Hz and above 5000 Hz.
Processed file normalization (-3 dB): The Adobe Audition normalize process tool was applied to normalize 
the audio at -3 dB.
Additional Clarification: Adobe Audition version 25.2.0.123 was used to clarify the audio recording. The 
audio was processed in this order: 1) Speech Leveler tool to balance the sound of speech. 2) The notch 
filter was applied. 3) The 30 band EQ tool was applied. 4) The normalization tool was applied. 5) The 
clarified audio was saved as an uncompressed wav file.

KJNALR

Continuous tone attenuation: Audition - applied the Notch filter for 1.2k noise
Noise reduction: Audition - applied noise reduction 60% and reduced by 20dB for effective tone 
attenuation
Processed file normalization (-3 dB): Audition - Normalize to -3dB to ensure the audio maintains a 
consistence volume level with out distortion
Additional Clarification: The audio was reported to have been recorded from a cellular phone in the POIs 
pocket. Due to the motion of the phone in that pocket, there is significant interference as the microphone 
appears to be rubbing on the pocket fabric. This had a negative effect on the efficacy of the enhancement 
and prevents a full enhancement of all speech.

LNANPN

Continuous tone attenuation: -Adobe Audition, Notch filter (frequency 1200 Hz, Gain -50dB)
Noise reduction: -Adobe Audition, Parametric equalizer (high pass filter; 250 Hz, Gain 24dB/Oct)
Processed file normalization (-3 dB): -Adobe Audition, Normalize (-3dB)
Additional Clarification: -Adobe Audition, iZotope RX10 plugin De-clip (high quality, -1dB) -Adobe 
Audition, Dynamic processing; to increase quiet speech (between -20 and -40 dB) -Adobe Audition 
Parametric equalizer; increased higher voice frequencies to clarify speech (frequency 2800hz, Gain 7dB)

M84GBM

Continuous tone attenuation: Audio file was uploaded into OTExpert 6.0, under the Edit > Filter option, 
used Target filtering and select the range 1180Hz to 1210Hz. Set the frequency to -10dB to reduce the 
continuous tone attenuation.
Noise reduction: Under Edit > Filter > Subtract noise. Set the values as Range: 50 to 400Hz, out of 
range: -3dB with Change noise energy of 0.1 and substract spectrum.
Processed file normalization (-3 dB): Under Edit > Normalization, tick only the Normalize and set to 70% 
of maximum which is equivalent to -3dB.
Additional Clarification: [Not reported by participant.]

M9ELLP
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Continuous tone attenuation: Izotope EQ band filter at 1200 Hz
Noise reduction: Izotope Normalization to -0.70, De-click, De-Rustle, Voice De-noise adaptive mode, 
De-plosive modules
Processed file normalization (-3 dB): Izotope Normalization
Additional Clarification: Izotope Leveler module

MFYM4N

Continuous tone attenuation: A continuous tone was observed at 1200Hz throughout the recording. This 
was attenuated using Izotope RX10 Pro EQ module with a notch filter applied at 1200Hz (Q40, -60 dB 
gain). This process reduced the interfering tone while preserving intelligibility.
Noise reduction: A. De-click Algorithm: Multi-band (Random Clicks) Settings: Sensitivity 8.6, Bias 0.9 
Purpose: Removed sharp transient spikes caused by basketball impacts and friction bursts. Result: 
Smoother waveform with fewer distracting high-energy peaks. B. De-crackle Mode: High Quality Strength: 
8.3 Purpose: Reduced low-level grain and fine crackle generated by fabric rubbing. Result: Produced a 
cleaner background with reduced constant static noise. C. Equalization (EQ) Mode: Analog EQ 
Adjustments: - High Shelf @ 200 Hz (+0.19 dB) – restored mild low-end warmth. - Notch Filter @ 1200 
Hz (–60 dB, Q = 400) – removed persistent hum. - Low Roll-off @ ≈62 Hz – attenuated sub-bass from 
basketball thumps. Result: The hum was fully eliminated, and the vocal range became clearer and more 
balanced. D. Clip Gain Automation Method: Manual node editing (multiple add/move operations). 
Purpose: Evened out the inconsistent amplitude caused by the movement of the recording device against 
the fabric. Result: Achieved consistent loudness across speech regions without compressing natural 
dynamics. E. De-rustle (Multiple Passes) in isolated areas Settings: Strength 1.6–6.3; Ambience 
Preservation 43–81. Purpose: Incrementally reduced broadband rustle while retaining natural background 
presence. Result: improvement in clarity, with rustling reduced to a minimal level.
Processed file normalization (-3 dB): Final Step: Normalized to –3 dB peak using Izotope RX10 Pro as per 
test specification. Purpose: Ensured consistent output level for playback while preserving headroom. Result: 
Standardized overall loudness, completing the enhancement chain.
Additional Clarification: Workflow Sequence 1. Critical Listening and Assessment - Identified eight clipped 
points (non-speech) — no de-clipping required. - Noted primary noise sources: rustle, hum, and impact 
transients. 2. File Conversion (Audacity – Lossless WAV Export) 3. De-click and De-crackle for transient 
and background smoothing. 4. EQ Correction to remove 1200 Hz hum and balance frequencies. 5. Clip 
Gain Automation for manual dynamic control. 6. Multiple De-rustle Passes for broadband noise reduction 
in selected areas 7. Normalization to –3 dB for final level alignment.

MND7MM
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Continuous tone attenuation: The wind noise in voicemail-2095(audio) was very high, so I used the 
MyEdit Wind Remover tool to reduce it. After reducing the wind noise, the resulting voicemail-2095(audio) 
file was resampled to a normal sampling rate, and all further processing was carried out at this rate. To 
reduce noise and increase the intelligibility of voicemail-2095(audio), I have used different filters of the 
Gold Wave and Audacity tools; the filters used in this action were: 1. A high-pass filter was applied to 
remove low-frequency noise and improve the clarity of the voicemail-2095(audio). The procedure was as 
follows: open Gold Wave software > import the audio file (File > Open) > select all. Go to Effect > 
Filter > Low/Pass Filter and apply the following settings: initial cutoff at 70 Hz, final cutoff at 90 Hz, 
high-pass mode with dynamic enabled, steepness set to 12, and the preset of Fade Out Bass > ok. 2. 
Noise reduction was applied to minimize unwanted sounds such as hum/buzz and other background 
disturbances, thereby improving the clarity and intelligibility of the voicemail-2095(audio). The procedure 
was as follows: open Gold Wave > import the audio file (File > Open) > highlight each section 
containing unwanted noise at the following time intervals: 21.940–22.071 s, 39.152–39.290 s, 
43.872–45.146 s, 55.405–57.831 s, 1:03.945–1:03.817 s, 1:26.015–1:29.009, 1:47.027–1:51.077 
s, 1:57.152–1:57.392 s, 2:28.087–2:28.372 s, 2:37.001–2:40.002 s, 2:40.988–2:46.506 s, and 
2:48.036–2:52.887 s. For each selected segment, go to Effect > Filter > Noise Reduction > choose the 
preset Hiss Removal (-50 dB), and apply the following settings: FFT size of 12, overlap of 4x, and scale of 
100%. Afterward, I selected the entire audio file and go to Effect > Filter > Noise Reduction. I choose to 
Reduce Hum, then applied the following settings: FFT size 12, overlap 4x, and 100% scale. 3. An 
equalizer filter was used to adjust the levels of specific frequency ranges, allowing targeted enhancement 
or reduction of low, mid, and high frequencies in voicemail-2095(audio). This used to minimize unwanted 
noise without affecting the rest of the recording and improved the overall tonal balance. The procedure 
was as follows: open Gold Wave > import the audio file (File > Open), > select all. Go to Effect > Filter 
> Equalizer, choose the preset (Equal Loudness), and apply the automated Equal Loudness settings to 
complete the process. 4. A low-pass filter was applied to remove high-frequency noise during the audio 
enhancement process. This filter effectively reduced the persistent hiss in the recording and improved 
intelligibility by attenuating high-frequency noise that was masking the desired speech. The procedure was 
as follows: open Gold Wave > import the audio file > select the entire audio > go to Effects > Filter > 
Low/High-Pass Filter. Choose Low-Pass, select the preset (Muffled), and apply the automated settings. 
Muffled as preset (this automatically sets cutoff frequency and steepness) > Click OK. Software used: 
Gold Wave, Filter used: Low-Pass Filter (LPF), Mode used: Static, Cutoff Frequency: 800 Hz, Steepness: 
10, Preset: Muffled.
Noise reduction: Noise reduction was applied to minimize unwanted sounds such as hum/buzz and other 
background disturbances, thereby improving the clarity and intelligibility of the voicemail-2095(audio). 
The procedure was as follows: open Gold Wave > import the audio file (File > Open) > highlight each 
section containing unwanted noise at the following time intervals: 21.940–22.071 s, 39.152–39.290 s, 
43.872–45.146 s, 55.405–57.831 s, 1:03.945–1:03.817 s, 1:26.015–1:29.009, 1:47.027–1:51.077 
s, 1:57.152–1:57.392 s, 2:28.087–2:28.372 s, 2:37.001–2:40.002 s, 2:40.988–2:46.506 s, and 
2:48.036–2:52.887 s. For each selected segment, go to Effect > Filter > Noise Reduction > choose the 
preset Hiss Removal (-50 dB), and apply the following settings: FFT size of 12, overlap of 4x, and scale of 
100%. Afterward, I selected the entire audio file and go to Effect > Filter > Noise Reduction. I choose to 
Reduce Hum, then applied the following settings: FFT size 12, overlap 4x, and 100% scale.
Processed file normalization (-3 dB): To normalize voicemail-2095(audio) to –3 dB, I used Audacity. 
Normalization adjusts the overall amplitude of the recording so that it reaches a clear, and professional 
loudness level without changing its natural dynamics. This process ensures a balanced output, improves 
speech intelligibility, maintains consistent volume, and helps to prevent the distortion. The procedure was 
as follows: Open Audacity > import the audio file (File > Open) > select all > go to Effect > Volume 
and Compression > Normalize > set the peak amplitude to –3 dB > apply. After normalization, the 
audio was exported using the following procedures, File > Export Audio > choose export location and file 
name > Export normalized audio.
Additional Clarification: I downloaded the file 25-5591_Audio.zip from the CTS Portal and saved it to the 
computer for integrity verification. I calculated the MD5 and SHA1 hash values of the downloaded file 
(MD5: 819bbd94bc743b096860246e6b47dc25; SHA1: 
cb104af3b372c1abf5195ceb07607c95730983d3) and compared them with the reference values of 

MQUVMQ
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hash value that were provided by CTS, message digest five (MD5): 
819bbd94bc743b096860246e6b47dc25; and the hash secure algorithm one (SHA1): 
cb104af3b372c1abf5195ceb07607c95730983d3. The matching results confirmed that the downloaded 
file was intact and unaltered. After verifying the file's integrity, I proceeded to extract the contents of the ZIP 
archive. The file contained inside: voicemail-2095(audio), audio assessment made using the media info. 
format: PCM, codec ID:1, duration: 3min0sec, bit rate:128kb/s, channel:1, sampling rate:8000Hz, bit 
depth:16bits. The listenability of this voicemail-2095 was very low, caused by different signs that were 
understandable as wind noise (very high), tones(hiss or Hum/buzz),etc…. Second, the wind noise in 
voicemail-2095 was very high, so I used the MyEdit Wind Remover tool to reduce it. After reducing the 
wind noise, the resulting voicemail-2095 file was resampled to a normal sampling rate, and all further 
processing was carried out at this rate.

Continuous tone attenuation: A Notch Filter was applied at 1200 Hz using the DC live. The gain at 1200 
Hz was reduced to weaken the continuous tone without making the speech harder to understand.
Noise reduction: A 10 Band Graphic EQ was applied to reduce the background noise in the audio, we 
lowered the low frequencies (31-125 Hz) and raised the middle frequencies (500-2000 Hz) so the speech 
becomes clearer and we kept the high frequencies (8000-1600 Hz) low to reduce the hiss , after adjusting 
the levels we applied the EQ to the audio.
Processed file normalization (-3 dB): The processed audio was normalized to a peak level of -3 dBs using 
the Normalize function in DC live to ensure consistent playback volume while preventing clipping.
Additional Clarification: [Not reported by participant.]

PD7AHM

Continuous tone attenuation: iZotope RX 10 EQ module: notch consisting of -60 dB at 1200 Hz, bell with 
Q=400.
Noise reduction: iZotope RX 10 De-click to reduce transients in masking noise: Algorithm = Multi-band 
periodic clicks; Frequency skew = 6.1; Sensitivity = 6.6; Click widening = 3 ms iZotope RX 10 De-wind 
to reduce lower frequencies in masking noise: Reduction = 2.7; Crossover frequency = 1500 Hz; 
Fundamental recovery = 5.0; Artefact smoothing = 10.0 iZotope RX 10 De-ess to reduce higher 
frequencies in masking noise: Algorithm = Spectral; Threshold = -9.5 dBFS; Cuttoff freq = 800 Hz; 
Speed = fast; Spectral Shaping = 11%; Spectral tilt = +53 iZotope RX 10 EQ to reduce low frequency 
noise: High pass brick wall filter at 130 Hz Zynaptiq Unfilter: adaptive filter to reduce convolution on 
speech and increase intelligibility by flattening frequency response.
Processed file normalization (-3 dB): iZotope RX 10 Loudness Control: True peak = -3.0 dBTP; Integrated 
loudness = - 18 LKFS; Tolerance = 2.0 LU; program loudness gate = on
Additional Clarification: iZotope RX 10 Leveler was used to increase level of voices relative to masking 
noise peaks: Optimise for dialogue; Target level = -20 dB FS; Responsiveness = 0.6; Preserve dynamics 
= 0 Replay of processed WAV file was confirmed on standard [Laboratory] Service Windows PC using VLC 
media player.

PK6UJH
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Continuous tone attenuation: Tonal Noise Removal: The file was imported into Audacity software. To 
identify the frequency value of the tonal noise present and presence of any harmonics, Plot spectrum 
feature of audacity was used. Only tonal noise area was selected at different selection points in audio file 
and spectrum was obtained using Plot spectrum. A sharp tonal noise at 1200 Hz was identified by 
selecting different areas where only tonal noise was present. After that whole audio was selected, and 
Notch filter was applied at 1200 Hz with Q=50. Notch Filter Settings: Frequency: 1200 Hz Q: 50 
(Screenshots in case folder) Manual Selective Editing: To remove remaining tonal noise at the start of 
audio, amplification to -50 dB was applied on that small tonal segment only.
Noise reduction: Noise Reduction Filter: A section of the recording containing just pocket friction/ 
rubbing/ masking noise was selected and the noise profile was generated using Noise Reduction filter "Get 
Noise Profile". After that all the whole audio file was selected and Noise was reduced with following 
parameters. Noise Reduction Filter
Noise reduction: 12 dB Sensitivity: 3 Frequency Smoothing: 8 bands High-Pass Filter: Cut below 80Hz 
Roll-off/Slope: 12 dB/oct is applied in High pass filter to reduce low-frequency basketball thumps without 
removing them. To reduce Remove rumble and low-frequency noise. Legacy Compressor: (To Smooths 
speech levels before manual enhancement/ boosting. Even out speech peaks without raising noise too 
much) Threshold: -35 dB Noise Floor: -50 dB Ratio: 3:1 Attack: 0.1 sec Release: 3 sec or at most 5sec 
Make-up gain for 0 dB after compressing (Selected) Compress based on Peaks (Deselected) Manual 
Selective Editing: (To Boost low voices and suppress noise without damaging speech.) Speech segments 
Only: Speech/ voice segments only are amplified using 0.75dB, +3dB to +10dB on vocal/ voice 
selections depending upon voice levels while avoiding clipping for raise voice levels Noise-only segments: 
Amplify -10 dB to -15dB (to suppress noise only regions). (Screenshots saved at each step). Graphic EQ 
Filter: (To clarify speech intelligibility) 2kHz–4 kHz frequency range is boosted by +2 dB
Processed file normalization (-3 dB): Normalization: Normalize peak amplitude: -3dB Remove Dc offset 
(Selected). The clarified/ enhanced audio is saved in the uncompressed PCM Wave format, maintaining 
the original file sample rate.
Additional Clarification: The work flow is provided in order of enhancement steps. Clarifications performed 
are mentioned in Noise Reduction Section.

Q29QFM

Continuous tone attenuation: Adobe Audition 23.3.0.55: Graphic Equalizer (30 bands), attenuate 
1.25kHz tone
Noise reduction: Adobe Audition 23.3.0.55: Parametric Equalizer, Generic Hi-Pass Preset, frequency 
20Hz set to -38.5dB gain and 112Hz set to -17.2 dB to attenuate rustling noise.
Processed file normalization (-3 dB): Saved the processed file out as instructed with same 8000Hz sample 
rate as PCM WAV file. Reimported to Adobe Audition 23.3.0.55, Normalize to -3dB as instructed, then 
saved as an 8000Hz sample rate as PCM WAV file.
Additional Clarification: Adobe Audition 23.3.0.55: Declicker - 44 of 45 clicks repaired. Adobe Audition 
23.3.0.55: Speech Volume Leveler, Soft preset.

Q2LH7H

Continuous tone attenuation: Select the time segment from 00:03.645 to 00:04.500 as the noise sample, 
and perform noise reduction on the entire recording.
Noise reduction: Use the vocal enhancement function to enhance the male voice.
Processed file normalization (-3 dB): Apply the normalization function with the parameter set to -3 dB.
Additional Clarification: Locate the segments with suspected basketball sounds and increase the gain by 
10 dB.

R9ZQ8K
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Continuous tone attenuation: Tool used: iZotope RX10 Advanced Audio Editor v10.5.0.2330 Filter used: 
Spectral Repair: Attenuate Frequency Range to Apply: 1150 to 12500 Hz Parameters set: Bands: 1024, 
Multi-resolution: ON, Surrounding region length (%): 50, Before/after weighting: 0.0, Strength: 1.0, 
Direction of interpolation: Vertical
Noise reduction: Tool used: iZotope RX10 Advanced Audio Editor v10.5.0.2330 Filter used: EQ 
Parameters set: High Pass 48 dB/oct 70 Hz Freq, Low Pass 48 dB/oct 2600 Hz Freq Filter used: De-rustle 
Parameters set: Reduction strength: 5.5, Ambiance preservation (%): 75, Separation algorithm: Advanced 
joint-channel Filter used: De-wind Parameters set: Reduction: 4, Crossover frequency (Hz): 1000, 
Fundamental recovery: 0.0, Artifact smoothing: 5.0 Filter used: De-click Parameters set: Algorithm: 
Multi-band (random clicks), Sensitivity: 8.5, Frequency skew: -4.0, Click widening (ms): 3.0 Filter used: 
Spectral De-noise Parameters set: Adaptive mode: ON, Learn time (s): 2.5, Threshold Noisy: 0.0, 
Threshold Tonal: 1.0, Reduction Noisy: 19.0, Reduction Tonal: 14.0, Quality: C, Artifact control: 7.0, 
Smoothing: 0.0 Algorithm Behavior Smoothing: 7.0, Algorithm Behavior Algorithm: Extreme, Algorithm 
Behavior Multi-resolution: ON, Noise Floor Synthesis: 0.0, Noise Floor Masking: 10.0, Noise Floor 
Enhancement: 5.0, Noise Floor Whitening: 4.0, Dynamics Knee: 1.5, Dynamics Release (ms): 80 Filter 
used: Leveler Parameters set: Optimize for: Dialogue, Target level: -30.7, Responsiveness: 1.5, Preserve 
dynamics: 35, Ess reduction (dB): OFF, Breath control (dB): OFF Export: Format: WAV, Bit depth: 32-bit 
(float), BWF: OFF
Processed file normalization (-3 dB): Tool used: iZotope RX10 Advanced Audio Editor v10.5.0.2330 Filter 
used: Normalize Parameters set: Target peak level (dBFS): -3.00 Export: Format: WAV, Bit depth: 32-bit 
(float), BWF: OFF
Additional Clarification: To transcode the original file for further clarification: Tool used: ffmpeg version 
7.1.1, parameters set: -c:a pcm_s32le

T9EARH

Continuous tone attenuation: Rewrapped M4A as PCM WAV retaining sample rate using a batch file 
containing the following FFMPEG script. for %%a in ("*.m4a") do ffmpeg -i %%a -acodec pcm_s16le 
%%~na_PCM.wav pause Created rewrapped file voicemail-2095_PCM.wav Opened 
voicemail-2095_PCM.wav in IZotope RX9 and listened to recording. The audio contains what sounds like 
a conversation between two individuals. Intelligibility of speech is poor and compression artefacts appear 
to be present. Speech levels vary and are often obscured by rustling and other environmental noises 
including a consistent percussive noise. Broadband background noise is low however the recording is 
marred by a continuous tone measured at 1200Hz at approximately -37dBFS in level. During the 
recording, the conversations are interspersed with what sounds like straining or grunting sounds which may 
indicate individuals involved in physical activity. Ran Waveform Stats across the whole recording: True 
Peak Level: +0.34dB Possible clipped samples: 8 DC Offset: -0.010% Applied De-Clip to repair clipping 
artefacts present on recording with threshold (dB) set to 7.0 and -7.0 and makeup gain of -3dB Applied 
De-Hum to remove DC Offset Ran Waveform Stats to check True Peal level -0.80dB Possible clipped 
samples: 0 DC Offset: 0.000% Continuous tone attenuation was achieved by applying Spectral Repair 
and cutting 1200Hz tone to -62dBFs
Noise reduction: Applied filters such as De-Rustle and De-Click in sections where speech was heard to 
attemp to improve intelligibility and reduce harshness to improve listenability. File saved as 
voicemail-2095_PCM_Working.wav Opened voicemail-2095_PCM_Working.wav in Adobe Audition to 
attempt to reduce dynamic range. Applied Compressor settings: Threshold: -34.9dB Ratio: 4:1 Attack: 
1ms Release: 304.1ms Makeup Gain 17dB
Processed file normalization (-3 dB): Applied Peak Normalisation to -3dB using Adobe Audition 
Normalisation filter.
Additional Clarification: After applying De-Rustle and De-Click, applied EQ with HPF from 150Hz 
12dB/Oct, 2.4dB boost at 1992Hz (1.4Q) and 5.8dB boost at 4kHz (2.1Q) to increase presence.

U7PMAE
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Continuous tone attenuation: Reduced 1200Hz tone using a high-Q notch filter (IIR). -50dB, Q=80
Noise reduction: Used static parametric EQ (FIR) to address low frequency noise, and mid frequency 
resonances including: Low shelf cut (210Hz), presence boost (3200Hz), and multiple notches to remove 
resonances (-6dB @ 336Hz, 677Hz, 585Hz). Used a compressor / Limiter to reduce dynamic range 
between target speech and high level device handling transients. (-16dB Threshold; 10:1 ratio; 0.1ms 
attack, 50ms release)
Processed file normalization (-3 dB): Cedar 'Peak Normaliser' set to -3dB (sample peak). 'True Peak' 
(inter-sample) estimated to be -0.96dB.
Additional Clarification: Cedar Cambridge signal path: File Replay > DC Filter > EQ-P(IIR -tone 
attenuation) > EQ-L(FIR - EQ noise reduction & clarification) > Compressor > Adaptive Limiter (-3dB) > 
Peak Normaliser > WAV File result

UEZPVE

Continuous tone attenuation: izotope RX 10
Noise reduction: Spectral repair, Ce-click, Ce-crackle, dialogue isolate
Processed file normalization (-3 dB): Normalisation 0
Additional Clarification: [Not reported by participant.]

VLFPQH

Continuous tone attenuation: iZotope RX Advanced 10.5.0 - Conversion of audio to WAV LPCM, 24 bit, 
sample rate maintained - De-hum. Notch Filter @ 1200 Hz, Q of 3000.
Noise reduction: iZotope RX Advanced 10.5.0 - De-Clip at -1 dBFS - De-click, sensitivity 3.0, no widening 
- High pass filter @ 100 Hz, 48 db/oct slope - Spectral Inverse Filter (Spectral denoise). Used samples 
where only static noise present - Dewind, crossover freq 640 Hz, reduction 4 - Leveler. Target -12.2. 
Responsiveness 1 second - Spectral Inverse Filter (Spectral denoise). Used samples where only static noise 
present - Transient noise attenuation - Manual gain, -48 dB in regions containing no speech - Main gain, 
+6 dB in regions containing low amplitude speech
Processed file normalization (-3 dB): iZotope RX Advanced 10.5.0 Normalisation -3 dB
Additional Clarification: A/B comparisons throughout A/B comparison at the end using Adobe Premiere 
Pro 25.5

YW8DBB

Continuous tone attenuation: I used Izotope RX 10 program: - chose 1200 Hz and cut it off
Noise reduction: Izotope RX 10: - using both spectral repair and spectral denoise (learn command) to 
attenuate all those parts of the signal that has disturbing sounds (one by one), expect those parts that have 
speech under the noise
Processed file normalization (-3 dB): Izotope RX 10: - normalization -3 dB
Additional Clarification: [Not reported by participant.]

YZ389C
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TABLE 2
 Question 2- 1 : Enhanced Audio Examination 

ResponseWebCode
Continuous tone attenuation: In Cedar Cambridge, I corrected waveform issues (clipping, discontinuous 
waveforms) and applied noise reduction and EQ.
Noise reduction: In Cedar Cambridge, attenuated the body and envelope of the noise transients using 
adaptive filters. Then applied layers of noise reduction that targeted specific activity across the frequency 
spectrum.
Processed file normalization (-3 dB): In Cedar Cambridge, I attenuated dynamic range using a spectral 
dynamic limiter and compressors. I exported the file into iZotope RX7 and adjusted the loudness to be 
consistent with the Audio Engineering Society (AES) [Country] region Loudness guidelines. I then 
normalised the file to -3dB as requested by this proficiency test.
Additional Clarification: The signal processing chain was as follows: 1. Import a working copy from a 
created E01 of provided files to Cedar Cambridge. 2. Correct clipping. 3. Correct discontinuous 
waveforms. 4. Attenuate continuous tone and surrounding frequencies with noise reduction. 5. High pass, 
transient attenuation and further continuous tone reduction with EQ. 6. Adaptive noise filters to remove 
body of noise. 7. Dynamic spectral limiter to tame harshness of noise transients. 8. Layered noise 
reduction targeting specific frequency ranges of the "noise". 9. Compression to tame the dynamic range 
and improve listenability of audio file. 10. Export the file from Cedar Cambridge using the following 
settings: pcm_s24le, 8000 Hz, 24 bit. 11. Import the file exported from Cedar Cambridge into iZotope 
RX7. 12. Correct waveform phase to allow accurate loudness measurements. 13. Apply target loudness 
settings. 14. Normalize to -3dB. 15. Export completed audio file using the following settings: pcm_s24le, 
8000 Hz, 24 bit. Refer to the Cedar Cambridge report and iZotope run sheet for the filters/settings 
applied.

Z2CVL9

Question 2-1: Describe the workflow used to clarify the audio, including specific software and filters 
applied.

This was a free form question on methods and tools used. No consensus response is expected. Consensus Result:
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Forensic Audio Enhancement Observations
TABLE 3

Part 2: Audio Enhancement Instructions - 
A. Process the audio using filters to reduce noise and increase the intelligibility of speech.
B. Save the clarified audio in the uncompressed PCM Wave format, maintaining the original file sample rate.
C. Normalize processed file to -3 dB. It is expected that no speech data will be degraded or lost due to the filtering 
process.

WebCode Observational Notes

4BPU69 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

4KV2K9 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step C observational note: The 
audio sample at 00:46.908 has a maximum sample peak level of -0.97 dB, and many other samples 
exceed -3 dB as well.

4VEDX8 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

6KCCX8 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

7B2AC8 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step C observational note: The 
maximum audio signal amplitude is 0 dB with two clipped samples.

7YALG8 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

8QCBL3 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step C observational note: The 
audio is normalized to -3 dB as requested. However, while the continuous tonal noise at 1,200 Hz 
was removed, the notch filter settings were too wide/deep. All frequency information from approx. 
1,080 Hz to 1,240 Hz was removed, including speech data.

9PWEU3 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step A observational note: 
While noise was reduced, over-filtration resulted in speech sounding overly rhythmic with 
unnatural/abrupt variations in loudness of speech. Step C observational notes: The audio is 
normalized to -3 dB as requested. However, low-level speech was removed by the filtering processes. 
Some portions of intelligible speech in the original recording were made unintelligible by over filtering 
(e.g., De-reverberation).

CK6D4X Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step C observational note: The 
audio sample at 00:44.607 has a maximum sample peak level of -0.78 dB, and other samples 
exceed -3 dB as well.

CN9ANZ Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step A observational note: 
Noise was reduced, however speech intelligibility was degraded. Step C observational note: The audio 
is normalized to -3 dB as requested. However, while the continuous tonal noise at 1,200 Hz was 
removed, the EQ filter removed almost all frequency information from approximately 750 Hz to 1,700 
Hz, including significant speech data. Additionally, "click" artifacts from another filtering process were 
added throughout the recording.

CUU2YZ Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

EXM6GW Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

F6YLNW Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.
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TABLE 3
Forensic Audio Enhancement Observations

WebCode Observational Notes

GW6VGV Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

JBVGZR Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

JEUTVR Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

JKL37Q Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

JRHZTT Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

JWEJVR Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

JXA3WT Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

KJNALR Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

LNANPN Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step C observational note: The 
maximum audio signal amplitude was 0 dB with over 50 clipped samples.

M84GBM Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

M9ELLP Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

MFYM4N Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following notes. A narrower Q (bandwidth) of the EQ 
filter avoids affecting a wider range of frequencies to attenuate just the tone.

MND7MM Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

MQUVMQ Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step B observational note: File 
was saved as PCM Wave but sample rate was changed to 16,000 Hz. Step C observational note: The 
maximum audio signal amplitude is 0 dB with multiple samples exceeding -3 dB.

PD7AHM Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

PK6UJH Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

Q29QFM Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

Q2LH7H Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following notes. The volume of the continuous tone 
was reduced, but it is still audible.

R9ZQ8K Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

T9EARH Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

U7PMAE Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.
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TABLE 3
Forensic Audio Enhancement Observations

WebCode Observational Notes

UEZPVE Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

VLFPQH Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step B observational note: File 
was saved as PCM Wave but sample rate was changed to 16,000 Hz. Step C observational note: The 
maximum audio signal amplitude is 0 dB.

YW8DBB Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps with the following exception(s). Step C observational note: The 
audio is normalized to -3 dB as requested. However, low-level speech was removed during the 
filtering process. The notes do not indicate what filter(s)/settings were applied via the iZotope RX 
Spectral Repair tool.

YZ389C Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.

Z2CVL9 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested audio enhancement steps.
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Additional Comments
TABLE 4

Additional CommentsWebCode

Prior to applying processing in RX10, I made a PCM wav copy of the file using FFMPEG v6.0 with 
sample rate at 44.1kHz at 24 bit. Following processing, i used FFMPEG to downsample the file to 
8000Hz as requested (bit depth kept at 24 bit). All processing reviewed against original unprocessed file 
before return. Overall I think processing has helped improve the listenability of the recording, effectively 
reducing the prominent tone and handling noise. There are sections of intelligible speech but further 
improvements to speech intelligibility have not been possible due to the low sample rate and codec 
attributes of the recording. I have also had this processing peer reviewed by another competent 
practitioner, with the following comments: "Assessed processing. A suitable approach with an 
improvement to listenability, mostly through the reduction of the 1.2kHz sine tone. Further processing is 
limited by the low-quality codec used. Experimented by swapping around the order of the De-Wind and 
EQ processes - no audible difference. No suggestions for improvement. I believe that the processing has 
been pushed as far as possible without having a detrimental effect on the intelligibility of speech."

4BPU69

The enhancement process was performed conservatively to preserve the integrity of the original speech 
characteristics. All filtering steps were limited to attenuation of tonal and broadband noise without 
altering the linguistic content, phonetic cues, or temporal structure of the recording. No portions of the 
audio were removed, replaced, or time-modified. All observations regarding the presence of additional 
background speech or activity are based solely on audible content revealed after noise reduction, and 
not on any interpretive or reconstructive processing.

6KCCX8

Forensic analysis of the voicemail recording revealed clear sounds of a bouncing basketball, shoe 
movement, and outdoor reverberation. These acoustic features are consistent with activity on a 
basketball court. Therefore, the findings indicate that the person of interest was playing a one-on-one 
basketball game during the period in which he claimed to be home alone, contradicting his alibi.

7B2AC8

Mono signals are particularly challenging to enhance. Once enhanced, the file appeared to feature 
either multiple players, or at least verbally active participants, commenting on the game and interacting 
throughout. This did not sound like a simple one-on-one game in a public space.

8QCBL3

I did not answer Question 1-6 since it was outside the laboratory scope of examination. I filled in 
answers to the questions since it's a requirement. I put the number 0 to satisfy answering the question

9PWEU3

Question 1-2 is not clear on whether it is asking for the format of the container or the format of the 
audio stream inside the container (containers can have multiple streams such as video, audio, and 
subtitles). If the question had been phrased “what is the codec or audio encoding scene used in the 
MPEG-4 container file” the answer would have been AAC. However, it asked for the “audio format” and 
that could be interpreted as Mp4a/m4a or AAC. Sometimes multimedia definitions such as container, 
format, file type, extension, etc. are used interchangeably or inconsistently. Question 1-7 is difficult to 
definitively answer, because the Waveform Statistics in iZotope RX indicate “Possibly clipped samples” 
and the number is very low at “8.” A different audio tool, Adobe Audition, reported that there are only 2 
possibly clipped samples. Digital metering can be unreliable with such short durations (less than one 
thousandths of a second at 8 kHz sample rate) and it is hard to say if measurement uncertainty is the 
cause, or if there truly is clipping.

EXM6GW

I don’t usually use an additional application to normalize audio files but since the request was so specific 
I used one that could be set numerically. I also did not use adaptive filters that can sometimes attenuate 
small amounts of speech since the request required that no speech data will be degraded or lost.

JBVGZR

Since the file in mpeg 4 format gave problems when opened with the version of the RX iZotope software 
available in this Laboratory, before starting the improvement process, it was converted to PCM format 
using the code: ffmpeg -i voicemail-2095.m4a -c:a pcm_s16le voicemail-2095_ffmpeg.wav from the 
FFMPEG library.

JEUTVR

* Question 1-2 was unclear. As written, the question appears to refer to the container itself while the 
more logical subject of the question would refer to the audio within the container.

MFYM4N

The original file voicemail-2095.m4a was processed in DC live A notch Filter at 1200 Hz was applied to 
reduce the continuous tone. A 10 Band Graphic EQ was applied to reduce the background noise in the 
audio; The final audio was normalized to –3 dB and exported as a WAV file. All speech content was 

PD7AHM
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Additional CommentsWebCode

preserved throughout the enhancement process. The improved quality allowed clearer identification of 
the background activity. It was determined that the individual in the recording was walking while 
speaking, and there were additional voices indicating interaction with other persons present at the scene.

Downloaded ZIP archive was copied to laboratory workstation and SHA-1 hash was verified with 
QuickHash software before target M4A file was extracted. Some dynamics processing was required to 
reduce the level disparity between the masking noises and the speech signal, thus the iZotope RX 10 
Leveler and Loudness Control modules were used to this effect.

PK6UJH

The “Part 2: Audio Enhancement Instructions” were followed as provided by CTS, and according to 
section 4 of the SWGDE Best Practices for the Enhancement of Digital Audio, and an enhanced/ clarified 
audio file was exported. (Screenshots) were saved at each step. One zip file is provided containing 
enhanced audio file. Hash Value of Enhanced file: "Enhanced voicemail-2095.wav" is: MD5: 
3aea91f8fc73497de3b19ed0b04009b1

Q29QFM

Little improvement was made to the overall intelligibility of the recording due to the apparent 
concealment of the recording device and rustling noises that marred the recording. Some sections of the 
recording were made clearer by removing rustling and clicks. At 1.17.6s (621517 samples) and 2:27s 
(1180173 samples), phrases sound clearer and may be of investigative value. At 30.399s (243197 
samples) a sound like a dog barking is present. At 2:27.5s (1180173 samples) a percussive impact 
sound can be heard. Please Note: During the zip file verification process, I noticed an anomaly between 
the SHA1 and MD5 hash ids. The hash strings I generated from the zip file are not the same as those 
listed. I raised this issue with my Quality Unit who contacted CTS. CTS maintained the hash IDs are 
correct, but I am unable to get a match despite using four applications to verify, all with the same results. 
(See uploaded email chain). [Email chain not included in this report.]

U7PMAE

Processed audio file was a "working copy" copied from an E01 created of the provided USB 3.0 flash 
drive. All file copy and transfers were MD5 or SHA-256 hash verified using NUIX Evidence Mover or 
TeraCopy.

Z2CVL9

-End of Report-
(Appendix may follow)
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Test No. 25-5591: Forensic Audio Analysis

DATA MUST BE SUBMITTED BY Nov. 24, 2025, 11:59 p.m. EST TO BE INCLUDED IN THE REPORT

Participant Code: U1234A WebCode: FDWDWQ
Test Instructions:
1. Apply filtration to reduce masking noise and increase the intelligibility of speech in the recording.
2. Guidelines described in section 4 of the SWGDE Best Practices for the Enhancement of Digital Audio should be followed.
3. Answer questions regarding the audio file properties, attributes of the audio content, and procedures to clarify the
speech.

Scenario:
A person of interest (POI) claims that he was home alone during a specific time window relevant to an ongoing investigation.
However, a voicemail stored on a third party’s phone reveals that the POI’s cellular phone, during that same period,
inadvertently placed a call from a pocket during a one-on-one basketball game at a public court.

Investigators would like to examine the voicemail recording to determine whether any speech or background sounds
captured during the call contradict the individual’s stated alibi. Audio clarification processing is needed to improve
listenability and increase intelligibility through noise reduction and speech clarification.

This test is designed to measure your knowledge and skill in the following digital forensic audio processes: Data verification, Media
characterization, Audio processing, and Audio enhancement. These are based on the competencies outlined in section 3.6 of the SWGDE Core
Competencies for Forensic Audio.

Evidence:
To verify a complete and accurate download, use the tool of your choice to verify the integrity of the file.
25-5591_Audio.zip MD5 hash value: 819bbd94bc743b096860246e6b47dc25
25-5591_Audio.zip SHA1 hash value: cb104af3b372c1abf5195ceb07607c95730983d3



 Test No. 25-5591 Data Sheet, continued Participant Code: U1234A
WebCode: FDWDWQ

Part 1: Examination Questions
1-1). What is the SHA-256 hash value of the voicemail-2095.m4a file?

1-2). What is the audio format of this MPEG-4 container file?

1-3). How many audio channels are contained in the audio file? Provide a NUMERIC response.

1-4). What is the length in time of the audio file? Provide your answer in the following format: MM:SS.

1-5). What is the sample rate of the audio file? Provide a NUMERIC response and the associated units.
Sample Rate:

Units:

1-6). What is the frequency value of the tonal noise present? Provide a NUMERIC response and the associated units.
Frequency Value:

Units:

Are harmonics of this tone present?

Yes  No 

1-7). Are any clipped audio samples present in the file?

Yes  No 



 Test No. 25-5591 Data Sheet, continued Participant Code: U1234A
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Part 2: Audio Enhancement Instructions
A. Process the audio using filters to reduce noise and increase the intelligibility of speech.
B. Save the clarified audio in the uncompressed PCM Wave format, maintaining the original file sample rate.
C. Normalize processed file to -3 dB. It is expected that no speech data will be degraded or lost due to the filtering process.

Uploaded file name:

2-1). Describe the workflow used to clarify the audio, including specific software and filters applied.
Continuous tone attenuation:

Noise reduction:

Processed file normalization (-3 dB):

Additional clarification:



 Test No. 25-5591 Data Sheet, continued Participant Code: U1234A
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Additional Comments
Note: Please use appropriate punctuation to indicate the end of sentences, sections, and statements in the free-form space below. Extra spacing and returns
used for separation within your text will not transfer and may cause your information to be illegible in the Summary Report. The use of lists and tabular formats
to deliver information is also cautioned against, as these do not transfer.
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Optional Questions

1: List software tools used to complete this test?

2: How long did this test take to complete?
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RELEASE OF DATA TO ACCREDITATION BODIES

The Accreditation Release is accessed by pressing the "Continue to Final Submission" button online and can be
completed at any time prior to submission to CTS.

CTS submits external proficiency test data directly to ANAB and/or A2LA. Please select one of the following
statements to ensure your data is handled appropriately.

 This participant's data is intended for submission to ANAB and/or A2LA. (Accreditation Release section below must be completed.)
This participant's data is not intended for submission to ANAB and/or A2LA.

Have the laboratory's designated individual complete the following steps
only if your laboratory is accredited in this testing/calibration discipline

by one or more of the following Accreditation Bodies.

Step 1: Provide the applicable Accreditation Certificate Number(s) for your laboratory

ANAB Certificate No.

A2LA Certificate No.

Step 2: Complete the Laboratory Identifying Information in its entirety

Authorized Contact Person and Title

Laboratory Name

Location (City/State)
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